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Chapter 1. Troubleshooting

Troubleshooting, or problem determination, is the process of determining why a certain product is
malfunctioning.

Note: You can resolve some problems by ensuring that your system matches the system requirements
listed in the IBM Tivoli Monitoring Linux OS Agent Installation and Configuration Guide.

See the following documents for general information about using the product:
v IBM Tivoli Monitoring Troubleshooting Guide

v IBM Tivoli Monitoring Administrator's Guide

v IBM Tivoli Monitoring User's Guide

Gathering product information for IBM Software Support
Before contacting IBM® Software Support about a problem you are experiencing with this product, gather
the following information that relates to the problem:

Table 1. Information to gather before contacting IBM Software Support

Information type Description

Log files Collect trace log files from failing systems. Most logs are located in a logs subdirectory
on the host computer. See Chapter 2, “Trace logging,” on page 3 for lists of all trace log
files and their locations. See the IBM Tivoli Monitoring User's Guide for general
information about the IBM Tivoli Monitoring environment.

Linux information v Version number and patch level
v Sample application data file (if monitoring a file)

Operating system Operating system version number and patch level

Messages Messages and other information displayed on the screen

Version numbers for
IBM Tivoli Monitoring

Version number of the following members of the monitoring environment:
v IBM Tivoli Monitoring. Also provide the patch level, if available.
v IBM Tivoli Monitoring: Linux OS Agent

Screen captures Screen captures of incorrect output, if any.

Core dump files If the system stops on UNIX or Linux systems, collect core dump file from
install_dir/bin directory, where install_dir is the directory path where you installed
the monitoring agent.

Built-in troubleshooting features
The primary troubleshooting feature in the IBM Tivoli Monitoring: Linux OS Agent is logging. Logging
refers to the text messages and trace data generated by the IBM Tivoli Monitoring: Linux OS Agent.
Messages and trace data are sent to a file.

Trace data captures transient information about the current operating environment when a component or
application fails to operate as designed. IBM Software Support personnel use the captured trace
information to determine the source of an error or unexpected condition. See Chapter 2, “Trace logging,”
on page 3 for more information.

© Copyright IBM Corp. 1994, 2013 1



Problem classification
The following types of problems might occur with the IBM Tivoli Monitoring: Linux OS Agent:
v Installation and configuration
v General usage and operation
v Display of monitoring data
v Take Action commands

This chapter provides symptom descriptions and detailed workarounds for these problems, as well as
describing the logging capabilities of the monitoring agent. See the IBM Tivoli® Monitoring Troubleshooting
Guide for general troubleshooting information.
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Chapter 2. Trace logging

Trace logs capture information about the operating environment when component software fails to
operate as intended. The principal log type is the RAS (Reliability, Availability, and Serviceability) trace
log. These logs are in the English language only. The RAS trace log mechanism is available for all
components of IBM Tivoli Monitoring. Most logs are located in a logs subdirectory on the host computer.
See the following topics to learn how to configure and use trace logging:
v “Principal trace log files” on page 4
v “Examples: using trace logs” on page 5
v “Setting RAS trace parameters” on page 6

Note: The documentation refers to the RAS facility in IBM Tivoli Monitoring as "RAS1".

IBM Software Support uses the information captured by trace logging to trace a problem to its source or
to determine why an error occurred. The default configuration for trace logging, such as whether trace
logging is enabled or disabled and trace level, depends on the source of the trace logging. Trace logging
is always enabled.

Log file management is described in the following table:

Table 2. Log file management on UNIX compared to log file management on Windows

Location of logs Description

v On a Windows monitoring server

v On a Windows computer where
the monitoring agent is running

v On a UNIX or Linux computer
where the monitoring agent is
running

On Windows, the log file is overwritten each time the component starts.
There is no automated method to archive previous RAS1 log files.
Note: To prevent the log files from consuming too much disk space, you can
stop and start the component. This action automatically creates a new log file.
Save a backup of log files if your company policy requires archiving of log
files.

v On a UNIX or Linux monitoring
server

v On a UNIX or Linux computer
where the monitoring agent is
running

On UNIX or Linux systems, because of the use of the &Timestamp; variable
in the log file names, multiple RAS1 logs are normally stored the logs
subdirectory. The file name for a trace log is a copy of a related file that
includes the process ID of the agent. The two files have the same timestamp
as in these examples from a computer with a host name f50pa2b. The
1112097194 part of the name is the timestamp:

f50pa2b_lz_1112097194.log
f50pa2b_lz_1112097194.pid60420

where lz is the unique, two-character code for Monitoring Agent for Linux
OS.

Note: When you communicate with IBM Software Support, you must capture and send the RAS1 log
that matches any problem occurrence that you report. Table 3 on page 4 can help you identify files that
are relevant to your troubleshooting efforts.
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Principal trace log files

Table 3 contains locations, file names, and descriptions of trace logs that can help determine the source of
problems with agents.

Table 3. Trace log files for troubleshooting agents

System where log
is located

File name and path Description

On the computer
that hosts the
monitoring agent

The hostname_lz_instance.log file is located in
the install_dir/logs path.

Traces activity of the monitoring agent.

The *.LG0 file is located in the following
subdirectory of the install_dir path: /logs.

Shows whether agent was able to connect
to the monitoring server. Shows which
situations are started and stopped, and
shows other events while the agent is
running. A new version of this file is
generated every time the agent is restarted.

IBM Tivoli Monitoring generates one
backup copy of the *.LG0 file with the tag
.LG1. View .LG1 to learn the following
details regarding the previous monitoring
session:
v Status of connectivity with the

monitoring server.
v Situations that were running.
v The success or failure status of Take

Action commands.

The take_action_name.log file (where
take_action_name is the name of the Take Action
command) is located in the /logs subdirectory of
the install_dir path.

Traces activity each time a Take Action
command runs. For example, when a
hypothetical start_command Take Action
command runs, IBM Tivoli Monitoring
would generate a start_command.log file.

On the Tivoli
Enterprise
Monitoring Server

The candle_installation.log file in the
install_dir/logs path.

Provides details about products that are
installed.
Note: Trace logging is enabled by default.
A configuration step is not required to
enable this tracing.

The Warehouse_Configuration.log file is located in
the following path on Windows:
install_dir\InstallITM.

Provides details about the configuration of
data warehousing for historical reporting.

The name of the RAS log file is as follows:

v On Windows: install_dir\logs\
hostname_ms_timestamp.log

v On UNIX or Linux: hostname_ms_timestamp.log
and hostname_ms_timestamp.pidnnnnn in the
install_dir/logs path, where nnnnn is the process
ID number.

Traces activity on the monitoring server.
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Table 3. Trace log files for troubleshooting agents (continued)

System where log
is located

File name and path Description

On the Tivoli
Enterprise Portal
Server

The name of the RAS log file is as follows:

v On Windows: install_dir\logs\
hostname_cq_timestamp.log

v On UNIX or
Linux: hostname_cq_timestamp.log and
hostname_cq_timestamp.pidnnnnn in the
install_dir/logs path, where nnnnn is the process
ID number.

Traces activity on the portal server.

The TEPS_ODBC.log file is located in the following
path on Windows: install_dir\InstallITM.

When you enable historical reporting, this
log file traces the status of the warehouse
proxy agent.

Definitions of variables:
timestamp is timestamp whose format includes year (y), month (m), day (d), hour (h), and minute (m), as follows:
yyyymmdd hhmm
install_dir represents the directory path where you installed the IBM Tivoli Monitoring component.
install_dir can represent a path on the computer that host the monitoring system, the monitoring agent, or the
portal.
instance refers to the name of the database instance that you are monitoring.
hostname refers to the name of the computer on which the IBM Tivoli Monitoring component runs.

See the IBM Tivoli Monitoring Installation and Setup Guide for more information on the complete set of
trace logs that are maintained on the monitoring server.

Examples: using trace logs
Typically IBM Software Support applies specialized knowledge to analyze trace logs to determine the
source of problems. However, you can open trace logs in a text editor to learn some basic facts about
your IBM Tivoli Monitoring environment.

Example one
This excerpt shows the typical log for a failed connection between a monitoring agent and a
monitoring server with the host name server1a:

(Thursday, August 11, 2005, 08:21:30-{94C}kdcl0cl.c,105,"KDCL0_ClientLookup") status=1c020006,
"location server unavailable", ncs/KDC1_STC_SERVER_UNAVAILABLE

(Thursday, August 11, 2005, 08:21:35-{94C}kraarreg.cpp,1157,"LookupProxy") Unable to connect to
broker at ip.pipe:: status=0, "success", ncs/KDC1_STC_OK

(Thursday, August 11, 2005, 08:21:35-{94C}kraarreg.cpp,1402,"FindProxyUsingLocalLookup") Unable
to find running CMS on CT_CMSLIST <IP.PIPE:#server1a>

Example two
The following excerpts from the trace log for the monitoring server show the status of an agent,
identified here as "Remote node." The name of the computer where the agent is running is
SERVER5B:

(42C039F9.0000-6A4:kpxreqhb.cpp,649,"HeartbeatInserter") Remote node SERVER5B:LZ is ON-LINE.
. . .
(42C3079B.0000-6A4:kpxreqhb.cpp,644,"HeartbeatInserter") Remote node SERVER5B:KLZ is OFF-LINE.

Key points regarding the preceding excerpt:
v The monitoring server appends the LZ product code to the server name to form a unique name

(SERVER5B:LZ) for this instance of Monitoring Agent for Linux OS. This unique name enables
you to distinguish multiple monitoring products that might be running on SERVER5B.

v The log shows when the agent started (ON-LINE) and later stopped (OFF-LINE) in the
environment.
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v For the sake of brevity an ellipsis (...) represents the series of trace log entries that were
generated while the agent was running.

v Between the ON-LINE and OFF-LINE log entries, the agent was communicating with the
monitoring server.

v The ON-LINE and OFF-LINE log entries are always available in the trace log. All trace levels
that are described in “Setting RAS trace parameters” provide these entries.

Setting RAS trace parameters
Objective

Pinpoint a problem by setting detailed tracing of individual components of the monitoring agent and
modules.

Background Information

Monitoring Agent for Linux OS uses RAS1 tracing and generates the logs described in Table 3 on page 4.
The default RAS1 trace level is ERROR.

Before you begin

When you are troubleshooting, follow these guidelines to ensure that you capture and analyze the correct
log files: Because of the use of the &Timestamp; variable in the log file names on UNIX or Linux systems,
there are typically multiple RAS1 logs in the logs subdirectory. When you forward log files to IBM
Software Support, you must send the RAS1 log that matches the problem occurrence that the log files are
reporting.

After you finish

On UNIX or Linux, periodically prune the trace logs in the logs subdirectory so that there is available
disk space for new logging.

Note: The KDC_DEBUG setting and the Maximum error tracing setting can generate a large amount of
trace logging. Use them only temporarily, while you are troubleshooting problems. Otherwise, the logs
can occupy excessive amounts of hard disk space.

Procedure

Specify RAS1 trace options in the install_dir/config/lz.ini file. The basic format for setting tracing
options is as follows:
KBB_RAS1=ERROR (UNIT:klz options)

Use one of the following methods to modify trace options:
v Manually edit the configuration file to set trace logging

1. Open the trace options file: /install_dir/config/lz.ini.
2. Edit the line that begins with KBB_RAS1= to set trace logging preferences.

For example, if you want detailed trace logging, set the Maximum Tracing option:
export KBB_RAS1=’ERROR (UNIT:klz ALL) (UNIT:kra ALL)’

3. Restart the monitoring agent so that your changes take effect.
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Chapter 3. Problems and workarounds

The known problems and workarounds are organized into types of problems that might occur with an
agent, for example installation and configuration problems and workspace problems.

The following topics provide symptoms and workarounds for problems that might occur with Monitoring
Agent for Linux OS:
v “Installation and configuration troubleshooting”
v “Agent troubleshooting” on page 13
v “Tivoli Enterprise Portal troubleshooting” on page 15
v “Troubleshooting for remote deployment” on page 15
v “Tivoli Common Reporting troubleshooting” on page 16
v “Situation troubleshooting” on page 16

Installation and configuration troubleshooting
Table 4 provides solutions for installation, configuration, and uninstallation problems.

Table 5 on page 10 provides solutions for uninstallation problems.

Table 4. Problems and solutions for installation and configuration

Problem Solution

When you upgrade to IBM Tivoli Monitoring, you
might need to apply fixpacks to Candle, Version
350, agents.

Fixpacks for Candle, Version 350, are delivered as each
monitoring agent is upgraded to IBM Tivoli Monitoring.
Note: The IBM Tivoli Monitoring download image or CD
provides application fixpacks for the monitoring agents that are
installed from that CD (for example, the agents for operating
systems such as Windows, Linux, UNIX, and i5/OS™). The
upgrade software for other agents is located on the download
image or CDs for that specific monitoring agent, such as the
agents for database applications.

If you do not upgrade the monitoring agent to IBM Tivoli
Monitoring, the agent continues to work. However, you must
upgrade to have all the functionality that IBM Tivoli
Monitoring offers.

install.sh fails with a JVMJ9VM011W error. The SELINUX parameter in the /etc/sysconfig/selinux file
must be set to "disable". Then, reboot the system.

Presentation files and customized OMEGAMON®

screens for Candle monitoring agents need to be
upgraded to a new Linux on z/Series system.

The upgrade from version 350 to IBM Tivoli Monitoring
handles export of the presentation files and the customized
OMEGAMON screens.
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Table 4. Problems and solutions for installation and configuration (continued)

Problem Solution

Installation of Monitoring Agent for Linux OS on
the Linux S390 R2.6 64-bit operating system fails
with a message similar to the following: LINUX
MONITORING AGENT V610Rnnn unable to install
agent, where nnn is the release number.

Solve this problem as follows:

1. Run the following command before running any installation
or configuration command for the agent:

export JAVA_COMPILER=NONE

2. Install the following two RPM (Red Hat Package Manager)
files:

v compat-libstdc++-295-2......s390x.rpm

v compat-libstdc++-33-3.......s390x.rpm It requires the
two s390x.rpm files, in addition to the s390.rpm files.

You can obtain the required RPM files from the CD for Red
Hat As 4.0 s390x.

During a command-line installation, you choose to
install a component that is already installed, and
you see the following warning:

WARNING - you are about to install
the SAME version of "component"

where component is the name of the component
that you are attempting to install.
Note: This problem affects UNIX command-line
installations. If you monitor only Windows
environments, you would see this problem if you
choose to install a product component (for
example, a monitoring server) on UNIX.

You must exit and restart the installation process. You cannot
return to the list where you selected components to install.
When you run the installer again, do not attempt to install any
component that is already installed.

The product fails to do a monitoring activity that
requires read, write, or execute permissions. For
example, the product might fail to run a Take
Action command or read a log.

The monitoring agent must have the permissions necessary to
perform requested actions. For example, if the user ID you
used to log onto the system to install the monitoring agent
(locally or remotely) does not have the permission to perform a
monitoring operation (such as running a command), the
monitoring agent is not able perform the operation.

While installing the agent from a CD, the
following message is displayed and you are not
able to continue the installation:

install.sh warning: unarchive of
"/cdrom/unix/cienv1.tar" may
have failed

This error is caused by low disk space. Although the
install.sh script indicates that it is ready to install the agent
software, the script considers the size of all tar files, not the
size of all the files that are contained within the tar file.Run the
df -k command to check whether the file systems have enough
space to install agents.

Cannot locate the KDCB0_HOSTNAME setting. Go to install_dir/config and edit the corresponding .ini file.
Set the KDCB0_HOSTNAME parameter followed by the IP
address. If you use multiple network interface cards (NICs),
give the Primary IP address of the network interface.

The Monitoring Agent for Linux OS repeatedly
restarts.

You can collect data to analyze this problem as follows:

1. Access the install_dir/config/lz.ini file, which is
described in “Setting RAS trace parameters” on page 6.

2. Add the following line: KBB_SIG1=trace –dumpoff

Agents in the monitoring environment use
different communication protocols. For example,
some agents have security enabled and others do
not.

Configure both the monitoring server and the Warehouse proxy
server to accept multiple protocols, as described in the IBM
Tivoli Monitoring Installation and Setup Guide.
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Table 4. Problems and solutions for installation and configuration (continued)

Problem Solution

Creating a firewall partition file: The partition file
enables an agent to connect to the monitoring
server through a firewall.

How it works: When the agents start, they search
KDCPARTITION.TXT for the following matches:

v An entry that matches the partition name OUTSIDE.

v An entry that also includes a valid external address.

For more information, see the IBM Tivoli Monitoring Installation
and Setup Guide.

You see the following error:

Hub not registered with location
broker. Error-code 1195.

Confirm that the password within the Tivoli Enterprise
Monitoring Server is correct.

The Monitoring Agent for Linux OS is started and
running but not displaying data in the Tivoli
Enterprise Portal.

Perform the following steps:

1. Open the Manage Tivoli Enterprise Monitoring Services
window.

2. Right-click the name of the monitoring server.

3. Select Advanced > Add TEMS Application Support in the
pop-up menu. Add application support if any for any agent
that is missing from the list. See in IBM Tivoli Monitoring
Installation and Setup Guide for more information on
adding application support.

4. Check the log files to see whether there are connection
problems.

5. If there are no connection problems, check whether the
agent has terminated.

6. If the agent is not terminated, confirm that you have added
application support for the Monitoring Agent for Linux OS
in the Tivoli Enterprise Monitoring Server as follows:

v Verify that the following entries are available in the
install_dir\candle_installation.log
file:install_dir\Install\IBM Tivoli Monitoring
timestamp.log

... Browser Client support for ITM Agent for Linux

... Desktop Client support for ITM Agent for Linux

If the candle_installation.log file does not have the
above entries for Monitoring Agent for Linux OS, add
application support for this monitoring agent. See in IBM
Tivoli Monitoring Installation and Setup Guide for more
information on adding application support.

v Verify that the following files are available in the
directory:

install_dir\ATTRLIB\klz.atrinstall_dir
\CNPS\CMSATR\klz.atrinstall_dir
\SQLLIB\klz.sqlinstall_dir
\CNPS\SQLLIB\klz.sql

Chapter 3. Problems and workarounds 9



Table 4. Problems and solutions for installation and configuration (continued)

Problem Solution

You successfully migrate an OMEGAMON
monitoring agent to IBM Tivoli Monitoring,
Version 6.2.0 or later. However, when you
configure historical data collection, you see an
error message that includes, Attribute name may
be invalid, or attribute file not installed
for warehouse agent.

Install the agent's application support files on the Tivoli
Enterprise Monitoring Server, by using the following steps:

1. Open the Manage Tivoli Enterprise Monitoring Services
window.

2. Right-click the name of the monitoring server.

3. Select Advanced > Add TEMS Application Support in the
pop-up menu. Add application support if any for any agent
that is missing from the list. See in IBM Tivoli Monitoring
Installation and Setup Guide for more information on
adding application support.

Ensure that the agent's application support files are pushed to
the system that houses the Warehouse Proxy Agent. The
Warehouse Proxy must be able to access the short attribute
names for tables and columns. That way, if the longer versions
of these names exceed the limits of the Warehouse database,
the shorter names can be substituted.

You receive the following error:
/data/itm/li6263/lz/bin/klzagent: error while
loading shared libraries: libstdc++.so.5:
cannot open shared object file: No such file
or directory

Ensure that the libstdc++.so.5 library is installed.

Table 5. General problems and solutions for uninstallation

Problem Solution

The way to remove inactive
managed systems (systems whose
status is OFFLINE) from the
Enterprise navigation tree in the
portal is not obvious.

When you want to remove a managed system from the navigation tree,
complete the following steps:

1. Click Enterprise in the navigation tree.

2. Right-click Workspace -> Managed System Status.

3. Right-click the offline managed system and select Clear offline entry.

Agent upgrade and restart using non-root
The monitoring agent can run by using a non-root user ID on UNIX and Linux systems. This can be done
by running the itmcmd agent start command while logged in as a non-root user, and this can be done
remotely by deploying the agent by using the Run As option on the GUI or by using the
_UNIX_STARTUP_.Username option on the tacmd addSystem command line. If the agent is running by
using a non-root user ID, and then the agent is upgraded, restarted remotely, restarted as a result of a
system reboot, or the itmcmd agent start is run by using the root user ID, then the monitoring agent
subsequently runs as the root user. To confirm the user ID that the monitoring agent is by using, run the
following command:
itm_install/bin/cinfo -r

If the agent is using root, and that is not the desired user ID, then use the following steps to restart the
agent:
1. Log in as root.
2. Run the itmcmd agent stop command.
3. Log in (or 'su') to the user ID that you want the agent to run as.
4. Run the itmcmd agent start command.
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If the agent was running as root because of a system reboot, then edit the startup file by using the
following steps so that the appropriate user ID is used the next time the system is rebooted:
1. Look at install_dir/registry/AutoStart, and get NUM.
2. Edit the autostart for your operating system:

The location of the startup file is platform dependent as follows:
v AIX®: /etc/rc.itmNUM
v HP-UX: /sbin/init.d/ITMAgentsNUM
v Linux: /etc/init.d/ITMAgentsNUM

v Solaris: /etc/init.d/ITMAgentsNUM
3. Add entries for your operating system by using the following command:

/usr/bin/su - instancename
-c "install_dir/bin/itmcmd agent
-h install_dir
-o instancename
start product_code"

Where:

instancename
Name of the instance

install_dir
Name of the directory

product_code
2-character product code for the agent, for example, lz for the Monitoring Agent for Linux OS

Examples:

v For AIX, add entries with the following format:
su - USER -c " /opt/IBM/ITM/bin/itmcmd agent
-o INSTANCE start lz”

Where:

USER Name of the user

INSTANCE
Name of the instance

v For Linux, HP_UX, and Solaris, add entries with the following format:
/bin/su - USER -c " /opt/IBM/ITM/bin/itmcmd agent
-o INSTANCE start lz >/dev/null 2>&1"

Where:

USER Name of the user

INSTANCE
Name of the instance

4. Repeat Steps 1 through 3 for all occurrences of stop.
5. Save the file.

Unique names for monitoring components
IBM Tivoli Monitoring might not be able to generate a unique name for monitoring components due to
the truncation of names that the product automatically generates.

IBM Tivoli Monitoring automatically creates a name for each monitoring component by concatenating the
host name and product code separated by colons (hostname:LZ).
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Note: When you monitor a multinode system, such as a database, IBM Tivoli Monitoring adds a
subsystem name to the concatenated name, typically a database instance name.
The length of the name that IBM Tivoli Monitoring generates is limited to 32 characters. Truncation can
result in multiple components having the same 32-character name. If this problem happens, shorten the
hostname portion of the name as follows:
1. Open the configuration file for the monitoring agent, which is located in the following path:

install_dir/config/lz.ini.
2. Find the line the begins with CTIRA_HOSTNAME=.
3. Type a new name for host name that is a unique, shorter name for the host computer. The final

concatenated name including the subsystem name, new host name, and LZ, cannot be longer than 32
characters.

Note: You must ensure that the resulting name is unique with respect to any existing monitoring
component that was previously registered with the Tivoli Enterprise Monitoring Server.

4. Save the file.
5. Restart the agent.
6. If you do not find the files mentioned in Step 1, perform the workarounds listed in the next

paragraph.

If you cannot find the CTIRA_HOSTNAME environment variable, you must add it to the configuration
file of the monitoring agent:
v On UNIX and Linux: Add the variable to the config/product_code.ini file.
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Agent troubleshooting
Table 6 provides agent-specific troubleshooting information. For general troubleshooting information, see
the IBM Tivoli Monitoring Troubleshooting Guide.

Table 6. Agent problems and solutions

Problem Solution

A configured and running
instance of the monitoring agent is
not displayed in the Tivoli
Enterprise Portal, but other
instances of the monitoring agent
on the same system do appear in
the portal.

Tivoli Monitoring products use Remote Procedure Call (RPC) to define and
control product behavior. RPC is the mechanism that allows a client process to
make a subroutine call (such as GetTimeOfDay or ShutdownServer) to a server
process somewhere in the network. Tivoli processes can be configured to use
TCP/UDP, TCP/IP, SNA, and SSL as the desired protocol (or delivery
mechanism) for RPCs.

"IP.PIPE" is the name given to Tivoli TCP/IP protocol for RPCs. The RPCs are
socket-based operations that use TCP/IP ports to form socket addresses. IP.PIPE
implements virtual sockets and multiplexes all virtual socket traffic across a
single physical TCP/IP port (visible from the netstat command).

A Tivoli process derives the physical port for IP.PIPE communications based on
the configured, well-known port for the HUB Tivoli Enterprise Monitoring
Server. (This well-known port or BASE_PORT is configured by using the
'PORT:' keyword on the KDC_FAMILIES / KDE_TRANSPORT environment
variable and defaults to '1918'.)

The physical port allocation method is defined as (BASE_PORT + 4096*N)
where N=0 for a Tivoli Enterprise Monitoring Server process and N={1, 2, ...,
15} for a non-Tivoli Enterprise Monitoring Server. Two architectural limits result
as a consequence of the physical port allocation method:

v No more than one Tivoli Enterprise Monitoring Server reporting to a specific
Tivoli Enterprise Monitoring Server HUB can be active on a system image.

v No more that 15 IP.PIPE processes can be active on a single system image.

A single system image can support any number of Tivoli Enterprise Monitoring
Server processes (address spaces) provided that each Tivoli Enterprise
Monitoring Server on that image reports to a different HUB. By definition, there
is one Tivoli Enterprise Monitoring Server HUB per monitoring Enterprise, so
this architecture limit has been simplified to one Tivoli Enterprise Monitoring
Server per system image.

No more that 15 IP.PIPE processes or address spaces can be active on a single
system image. With the first limit expressed above, this second limitation refers
specifically to Tivoli Enterprise Monitoring Agent processes: no more that 15
agents per system image.

This limitation can be circumvented (at current maintenance levels, IBM Tivoli
Monitoring V6.1 Fix Pack 4 and later) if the Tivoli Enterprise Monitoring Agent
process is configured to use EPHEMERAL IP.PIPE. (This is IP.PIPE configured
with the 'EPHEMERAL:Y' keyword in the KDC_FAMILIES /
KDE_TRANSPORT environment variable). There is no limitation to the number
of ephemeral IP.PIPE connections per system image. If ephemeral endpoints are
used, the Warehouse Proxy Agent is accessible from the Tivoli Enterprise
Monitoring Server associated with the agents by using ephemeral connections
either by running the Warehouse Proxy Agent on the same computer or by
using the Firewall Gateway feature. (The Firewall Gateway feature relays the
Warehouse Proxy Agent connection from the Tivoli Enterprise Monitoring
Server computer to the Warehouse Proxy Agent computer if the Warehouse
Proxy Agent cannot coexist on the same computer.)
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Table 6. Agent problems and solutions (continued)

Problem Solution

The Monitoring Agent for Linux
OS running on a Linux system
does not communicate with the
Tivoli Enterprise Monitoring
Server running on a Z/OS system.

The procedure for seeding the Tivoli Enterprise Monitoring Server running on a
Z/OS system for an instance of the Monitoring Agent for Linux OS running on
a Linux system can be found in Configuring Tivoli Enterprise Monitoring Server on
z/OS®.

The agent's process, klzagent uses
a large amount of system
resources.

In most cases, the problem occurs during the backup. Any one of the following
scenarios can cause this problem.

The agent is running during the backup
After backing up, the agent is started during system startup.

Multiple agents are running at the same time.
The computer that hosts the Tivoli Enterprise Monitoring Server was
rebooted and the agent has been installed by the root user account.

The agent is running during the backup
During the backup, some of the service might be interrupted or not be
available or locked for some amount of time. While the backup process
is going on, the Monitoring Agent for Linux OS, which is running
parallel, might wait for resources to be freed by the backup process.
When the backup is completed and you are viewing the agent, high
CPU at this point is expected, because the agent is in an uncertain state
(backup usually stops several kernel services that could cause this
state). For this reason, it is advisable to stop all agents before the
backup run, because there might be lost information, file, or API
connections. Stop the agent before the backup process starts.

The agent is started during system boot up:
If you use scripts to stop and start the agent, do not start the agent
from an init process script when you restart the system.

The computer that hosts the Tivoli Enterprise Monitoring Server was
rebooted and the agent has been installed by the root user account.
Verify whether the log file has the following information:

Unable to find running Tivoli Enterprise Monitoring Server on CMSLIST

Attributes do not allow non-ASCII
input in the situation editor.

None. Any attribute that does not include "(Unicode)" might support only
ASCII characters. For example "Attribute (Unicode)" will support unicode but
"Attribute" without "(Unicode)" might only support ASCII characters.

In the User workspace, data does
not show up in the User Login
Information (table view).

This problem arises when you install the agent on a 64-bit zLinux operating
system, but run the agent in 32-bit mode. The workspace is unable to access
user login data. Run the agent in 64-bit mode.

Query produces no historical data If you use wildcards within a query, the value does not act as a wildcard
against historical data. It acts simply as a value to compare against the values
in the historical table. However, the value does act as a wildcard against the
realtime data.

For example, if you use .*(LongDirName/sleep).* in the historical collection
configuration and use .*(LongDirName/sleep).* in a query as well, you will see
real time data and historical data. But, if you use .*(LongDirName/sleep).* in
the historical collection configuration, and then use .*(LongDirName/sle).* in
the query, then you will see real time data only and no historical data. The
value does not act as a wildcard against historical data.

The Xorg process does not display
within the OSLC-rich hover.

A limitation of the Linux OS Agent, the Xorg process does not display within
the OSLC-rich hover because the Linux OS Kernel allocates Xorg memory by
using its own slab cache.
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Table 6. Agent problems and solutions (continued)

Problem Solution

While working with the Linux
Machine Information attribute
group, you are alerted by the
following message:

sh: vmcp: command not found

The Linux Machine Information attribute group requires the vmcp
module/command for Linux on System z. This information is contained in the
error log file hostname_lz_timestamp.log.

Tivoli Enterprise Portal troubleshooting
Table 7 lists problems that might occur with the Tivoli Enterprise Portal.

Table 7. Tivoli Enterprise Portal problems and solutions

Problem Solution

Historical data collection is
unavailable because of
incorrect queries in the Tivoli
Enterprise Portal.

The column, Sort By, Group By, and First/Last functions are not compatible with
the historical data collection feature. Use of these advanced functions will make a
query ineligible for historical data collection.

Even if data collection has been started, you cannot use the time span feature if the
query for the chart or table includes any column functions or advanced query
options (Sort By, Group By, First / Last).

To ensure support of historical data collection, do not use the Sort By, Group By, or
First/Last functions in your queries.

See the IBM Tivoli Monitoring Administrator's Guide or the Tivoli Enterprise Portal
online Help for information on the Historical Data Collection function.

When you use a long process
name in the situation, the
process name is truncated.

Truncation of process names in the portal display is the expected behavior. 64 bytes
is the maximum name length.

You see the following
message: KFWITM083W Default
link is disabled for the
selected object; please
verify link and link anchor
definitions.

You see this message because some links do not have default workspaces.
Right-click the link to access a list of workspaces to select.

Troubleshooting for remote deployment
Table 8 lists problems that might occur with remote deployment and removal of agent software Agent
Remote Deploy.

Table 8. Remote deployment problems and solutions

Problem Solution

The removal of a monitoring agent fails when you
use the remote removal process in the Tivoli
Enterprise Portal desktop or browser.

This problem might happen when you attempt the remote
removal process immediately after you have restarted the
Tivoli Enterprise Monitoring Server. You must allow time for
the monitoring agent to refresh its connection with the Tivoli
Enterprise Monitoring Server before you begin the remote
removal process.
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Tivoli Common Reporting troubleshooting
Table 9 lists general problems that might occur with Tivoli Common Reporting.

Table 9. Tivoli Common Reporting problems and solutions

Problem Solution

Reports that are based on CCC Logs attributes,
such as the Top Situations By Status report and
the Situations History report, rely on raw data
from the Status_History table in the Tivoli Data
Warehouse. To ensure accurate and complete
reports, you might need to confirm historical
collection of CCC Logs data.

The Status_History table is populated by collecting historical
data from the monitoring server for CCC Logs data after you
select the Situation Status Log attribute group. Historical
collection of CCC Logs data can be confirmed by ensuring that
the UADVISOR situation for O4SRV_TSITSTSH appears in the
TEMS messages file.

On Windows, the kdsmain.msg file in the: %CANDLE_HOME%\CMS\
path.

On UNIX and Linux, the <hostname>_ms_<Timestamp>.log file in
the <InstallDirectory>/logs/ path.

Example entries in the TEMS messages log showing the
O4SRV_TSITSTSH attribute gathered in a UADVISOR situation
include:

v KO46256 Situation definition UADVISOR_O4SRV_TSITSTSH
created by *ENTERPRISE.

v KO41047 Situation UADVISOR_O4SRV_TSITSTSH distribution
HUB_TEMS1 added.

v KO41046 Monitoring for enterprise situation
UADVISOR_O4SRV_TSITSTSH started.

After historical data is collected and exported and following the
next warehousing interval of the TDW database, the
Status_History table will be populated with data required to run
the TCR reports using CCC Logs.

Situation troubleshooting
Table 10 lists problems that might occur with specific situations.

Table 10. Specific situation problems and solutions

Problem Solution

You want to change the appearance of
situations when they are displayed in a
Workspace view.

1. Right-click an item in the Navigation tree.

2. Select Situations in the pop-up menu. The Situation Editor window is
displayed.

3. Select the situation that you want to modify.

4. Use the Status pull-down menu in the lower right of the window to
set the status and appearance of the Situation when it triggers.
Note: This status setting is not related to severity settings in IBM
Tivoli Enterprise Console.
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Table 10. Specific situation problems and solutions (continued)

Problem Solution

Situations are triggered in the Tivoli
Enterprise Monitoring Server, but events
for the situation are not sent to the
Tivoli Enterprise Console® server. The
Tivoli Enterprise Monitoring Server is
properly configured for event
forwarding, and events for many other
situations are sent to the event server.

This condition can occur when a situation is only monitoring the status of
other situations. The event forwarding function requires an attribute
group reference in the situation in order to determine the correct event
class to use in the event. When the situation only monitors other
situations, no attribute groups are defined and the event class cannot be
determined. Because the event class cannot be determined, no event is
sent.

This is a limitation of the Tivoli Enterprise Monitoring Server event
forwarding function. Situations that only monitor other situations do not
send events to the event server.

Monitoring activity requires too much
disk space.

Check the RAS trace logging settings that are described in “Setting RAS
trace parameters” on page 6. For example, trace logs grow rapidly when
you apply the ALL logging option.

A formula that uses mathematical
operators appears to be incorrect. For
example, if you were monitoring Linux,
a formula that calculates when Free
Memory falls under 10 percent of Total
Memory does not work: LT
#’Linux_VM_Stats.Total_Memory’ / 10

This formula is incorrect because situation predicates support only logical
operators. Your formulas cannot have mathematical operators.
Note: The Situation Editor provides alternatives to math operators.
Regarding the example, you can select % Memory Free attribute and
avoid the need for math operators.

If you are running a Version 350
Monitoring Agent for Linux OS and you
choose to alter the views to include a
Version 610 UNICODE attribute, be
aware that data for this attribute is not
displayed and you see a blank column
in this view.

To enable Unicode and other features, upgrade the monitoring agent to
IBM Tivoli Monitoring, Version 6.2.0 or later.

IBM Tivoli Monitoring is configured to
provide data to the optional product
IBM Tivoli Enterprise Console.
However, a situation displays the
severity UNKNOWN in IBM Tivoli
Enterprise Console.

For a situation to have the correct severity in TEC for those situations
which are not mapped, you need to ensure that one of the following is
true:

v Specify the severity in the SITINFO column of the O4SRV.TSITDESC
table. For example use the values 'SEV=Critical' and 'SEV=Warning' for
the SITINFO column in your kxx.sql file, which adds application
support to the monitoring product.

—OR—

v Have the name of the situation ends with '_Warn' or '_Warning' for
WARNING severity and '_Cri' or '_Critical' for Critical severity

You see the 'Unable to get attribute
name' error in the Tivoli Enterprise
Monitoring Server log after creating a
situation.

Install the agent's application support files on the Tivoli Enterprise
Monitoring Server, by using the following steps:

1. Open the Manage Tivoli Enterprise Monitoring Services window.

2. Right-click the name of the monitoring server.

3. Select Advanced > Add TEMS Application Support in the pop-up
menu. Add application support if any for any agent that is missing
from the list. See in IBM Tivoli Monitoring Installation and Setup
Guide for more information on adding application support.

Events received at the Tivoli Enterprise
Console server from IBM Tivoli
Monitoring do not have values for all
event attributes (slots) even though the
values are visible in workspace views.

The problem is due to a limitation in the IBM Tivoli Monitoring interface
code that generates Tivoli Enterprise Console events from situations. The
situation results are provided in a chain of buffers of 3000 bytes each. The
interface code currently extracts event information from only the first
buffer. When situations or agent table data expands into a second buffer,
this additional data is not examined, and it is not included in events sent
to the Tivoli Enterprise Console server.
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Table 10. Specific situation problems and solutions (continued)

Problem Solution

Tivoli Enterprise Console events from
IBM Tivoli Monitoring for IBM Tivoli
Monitoring 5.x migrated situations
receive parsing errors in the Tivoli
Enterprise Console server.

Complete the following two steps:

1. Ensure that you have the IBM Tivoli Monitoring Event Sync installed
on your Tivoli Enterprise Console server.

2. Obtain updated baroc files from IBM Tivoli Monitoring for the
monitoring agent's events. Updated baroc files are on the Tivoli
Enterprise Monitoring Server in the CANDLEHOME/CMS/TECLIB/itm5migr
directory.

You are receiving Tivoli Business
Systems Management events that cannot
be associated due to application_oid and
application_class not being set.

The problem is due to IBM Tivoli Monitoring sending Tivoli Enterprise
Console events for IBM Tivoli Monitoring 5.x migrated situations. These
events are not able to set the cited slot values. Replace the
agent_name_forward_tbsm_event_cb.sh script on the Tivoli Enterprise
Console server with the version of this file from the Tivoli Enterprise
Monitoring Server in the CANDLEHOME/CMS/TECLIB/itm5migr directory.

Situations created using the File Pattern
attribute group are always TRUE if the
Match Count attribute is not used.

When creating situations using the File Pattern Attribute Group like the
following one:

[*IF *VALUE Linux_File_Pattern.File_Name *EQ ’/path/filename’
*AND *VALUE Linux_File_Pattern.Match_Pattern *EQ ’pattern’]

the situations are always TRUE.

Redefine the situations in the following way:

[*IF *VALUE Linux_File_Pattern.File_Name *EQ ’/path/filename’
*AND *VALUE Linux_File_Pattern.Match_Pattern *EQ ’pattern’ *AND
*VALUE Linux_File_Pattern.Match_Count *GT 0]

The Match_Count attribute must always be used in order to monitor for a
match pattern.

Problems with configuration of situations
Table 11 lists problems that might occur with situations.

Table 11. Problems with configuring situations that you solve in the Situation Editor

Problem Solution

Note: To display the Situation Editor, perform these steps:
1. Launch the Tivoli Enterprise Portal.
2. Click Edit > Situation Editor.
3. In the tree view, choose the agent whose situation you want to modify.
4. Choose the situation in the list. The Situation Editor view is displayed.

The situation for a specific agent is
not visible in the Tivoli Enterprise
Portal.

Open the Situation Editor. Access the All managed servers view. If the situation
is absent, confirm that application support for Monitoring Agent for Linux OS
has been added to the monitoring server. If not, add application support to the
server, as described in the IBM Tivoli Monitoring Installation and Setup Guide.

The monitoring interval is too
long.

Access the Situation Editor view for the situation that you want to modify.
Check the Sampling interval area in the Formula tab. Adjust the time interval
as needed.

The situation did not activate at
startup.

Manually recycle the situation as follows:

1. Right-click the situation and choose Stop Situation.

2. Right-click the situation and choose Start Situation.

Note: You can permanently avoid this problem by placing a check mark in the
Run at Startup option of the Situation Editor view for a specific situation.
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Table 11. Problems with configuring situations that you solve in the Situation Editor (continued)

Problem Solution

The situation is not displayed. Click the Action tab and check whether the situation has an automated
corrective action. This action can occur directly or through a policy. The
situation might be resolving so quickly that you do not see the event or the
update in the graphical user interface.

An Alert event has not occurred
even though the predicate has been
properly specified.

Check the logs, reports, and workspaces.

A situation fires on an unexpected
managed object.

Confirm that you have distributed and started the situation on the correct
managed system.

The product did not distribute the
situation to a managed system.

Click the Distribution tab and check the distribution settings for the situation.

The situation does not fire.

Incorrect predicates are present in
the formula that defines the
situation. For example, the
managed object shows a state that
normally triggers a monitoring
event, but the situation is not true
because the wrong attribute is
specified in the formula.

In the Formula tab, analyze predicates as follows:

1. Click the fx icon in the upper-right corner of the Formula area. The Show
formula window is displayed.

a. Confirm the following details in the Formula area at the top of the
window:
v The attributes that you intend to monitor are specified in the formula.
v The situations that you intend to monitor are specified in the formula.
v The logical operators in the formula match your monitoring goal.
v The numerical values in the formula match your monitoring goal.

b. (Optional) Click the Show detailed formula check box in the lower left
of the window to see the original names of attributes in the application
or operating system that you are monitoring.

c. Click OK to dismiss the Show formula window.

2. (Optional) In the Formula area of the Formula tab, temporarily assign
numerical values that will immediately trigger a monitoring event. The
triggering of the event confirms that other predicates in the formula are
valid.
Note: After you complete this test, you must restore the numerical values
to valid levels so that you do not generate excessive monitoring data based
on your temporary settings.

Table 12. Problems with configuration of situations that you solve in the Workspace area

Problem Solution

Situation events are not displayed
in the Events Console view of the
workspace.

Associate the situation with a workspace.
Note: The situation does not need to be displayed in the workspace. It is
sufficient that the situation be associated with any workspace.

You do not have access to a
situation.

Note: You must have administrator privileges to perform these steps.

1. Select Edit > Administer Users to access the Administer Users window.

2. In the Users area, select the user whose privileges you want to modify.

3. In the Permissions tab, Applications tab, and Navigator Views tab, select
the permissions or privileges that correspond to the user's role.

4. Click OK.

A managed system seems to be
offline.

1. Select Physical View and highlight the Enterprise Level of the navigator
tree.

2. Select View > Workspace > Managed System Status to see a list of
managed systems and their status.

3. If a system is offline, check network connectivity and status of the specific
system or application.
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Table 13. Problems with configuration of situations that you solve in the Manage Tivoli Enterprise Monitoring Services
window

Problem Solution

After an attempt to restart the
agents in the Tivoli Enterprise
Portal, the agents are still not
running.

Check the system status and check the appropriate IBM Tivoli Monitoring logs.

The Tivoli Enterprise Monitoring
Server is not running.

Check the system status and check the appropriate IBM Tivoli Monitoring logs.

The managed objects you created
are firing on incorrect managed
systems.

Check the managed system distribution on both the situation and the managed
object settings sheets.
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Documentation library

Various publications are relevant to the use of IBM Tivoli Monitoring and to the commonly shared
components of Tivoli Management Services.

These publications are listed in the following categories:
v IBM Tivoli Monitoring library
v Related publications

Documentation is delivered in the IBM Tivoli Monitoring and OMEGAMON XE Information Center at
http://pic.dhe.ibm.com/infocenter/tivihelp/v61r1/index.jsp and also in the Files section of the
Application Performance Management community.

For information about accessing and using the publications, select IBM Tivoli Monitoring → Using the
publications in the Contents pane of the IBM Tivoli Monitoring and OMEGAMON XE Information
Center at http://pic.dhe.ibm.com/infocenter/tivihelp/v61r1/index.jsp.

To find a list of new and changed publications, click the New in this release topic on the IBM Tivoli
Monitoring welcome page. To find publications from the previous version of a product, click Previous
versions under the name of the product in the Contents pane.

IBM Tivoli Monitoring library
The IBM Tivoli Monitoring library provides information about the commonly shared components of
Tivoli Management Services.
v Quick Start Guide

Introduces the components of IBM Tivoli Monitoring.
v Installation and Setup Guide, SC22-5445

Provides instructions for installing and configuring IBM Tivoli Monitoring components on Windows,
Linux, and UNIX systems.

v High Availability Guide for Distributed Systems, SC22-5455
Gives instructions for several methods of ensuring the availability of the IBM Tivoli Monitoring
components.

v Program Directory for IBM Tivoli Management Services on z/OS, GI11-4105
Gives instructions for the SMP/E installation of the Tivoli Management Services components on z/OS.

v Administrator's Guide, SC22-5446
Describes the support tasks and functions required for the Tivoli Enterprise Portal Server and clients,
including Tivoli Enterprise Portal user administration.

v Command Reference available on Service Management Connect
Provides detailed syntax and parameter information, as well as examples, for the commands you can
use in IBM Tivoli Monitoring.

v Messages available on Service Management Connect
Lists and explains messages generated by all IBM Tivoli Monitoring components and by z/OS-based
Tivoli Management Services components (such as Tivoli Enterprise Monitoring Server on z/OS and
TMS:Engine).

v Troubleshooting Guide available on Service Management Connect
Provides information to help you troubleshoot problems with the software.

v Tivoli Enterprise Portal User's Guide available on Service Management Connect
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Complements the Tivoli Enterprise Portal online help. The guide provides hands-on lessons and
detailed instructions for all Tivoli Enterprise Portal features.

v Tivoli Enterprise Portal online help
Provides context-sensitive reference information about all features and customization options of the
Tivoli Enterprise Portal. Also gives instructions for using and administering the Tivoli Enterprise
Portal.

Documentation for the base agents
If you purchased IBM Tivoli Monitoring as a product, you received a set of base monitoring agents as
part of the product. If you purchased a monitoring agent product (for example, an OMEGAMON XE
product) that includes the commonly shared components of Tivoli Management Services, you did not
receive the base agents.

The following publications provide information about using the base agents.
v Agentless operating system monitors

– Agentless Monitoring for Windows Operating Systems User's Guide, SC23-9765
– Agentless Monitoring for AIX Operating Systems User's Guide, SC23-9761
– Agentless Monitoring for HP-UX Operating Systems User's Guide, SC23-9763
– Agentless Monitoring for Solaris Operating Systems User's Guide, SC23-9764
– Agentless Monitoring for Linux Operating Systems User's Guide, SC23-9762

v OS agent documentation is delivered in the following locations:

Agent Installation and Configuration Guide
Available in the Information Center:
– IBM i OS Agent Installation and Configuration Guide, SC27-5653
– Linux OS Agent Installation and Configuration Guide, SC27-5652
– UNIX OS Agent Installation and Configuration Guide, SC27-5651
– Windows OS Agent Installation and Configuration Guide, SC27-5650

Agent Reference
Available on Service Management Connect

Agent Troubleshooting Guide
Available on Service Management Connect

Infrastructure Management Dashboards for Servers Reference
Available on Service Management Connect

v Warehouse agent documentation is delivered in the following locations:

Agent Installation and Configuration Guide
Available in the Information Center:
– Warehouse Proxy Agent Installation and Configuration Guide, SC27-5655
– Warehouse Summarization and Pruning Agent Installation and Configuration Guide, SC27-5654

Agent Reference
Available on Service Management Connect

Agent Troubleshooting Guide
Available on Service Management Connect

v System P agents
– AIX Premium Agent User's Guide, SA23-2237
– CEC Base Agent User's Guide, SC23-5239
– HMC Base Agent User's Guide, SA23-2239
– VIOS Premium Agent User's Guide, SA23-2238
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v Other base agents
– Agent Builder User's Guide, SC32-1921
– Performance Analyzer User’s Guide, SC27-4004
– Systems Director base Agent User’s Guide, SC27-2872
– Tivoli Log File Agent User’s Guide, SC14-7484
– Tivoli zEnterprise Monitoring Agent User’s Guide, SC14-7359 and the Tivoli zEnterprise Monitoring Agent

Installation and Configuration Guide, SC14-7358

Related publications
For information about related products and publications select OMEGAMON XE shared publications or
other entries in the Contents pane of the IBM Tivoli Monitoring and OMEGAMON XE Information
Center.

You can access the IBM Tivoli Monitoring and OMEGAMON XE Information Center at
http://pic.dhe.ibm.com/infocenter/tivihelp/v61r1/index.jsp .

You can also access other information centers at IBM Tivoli Documentation Central (https://
www.ibm.com/developerworks/community/wikis/home?lang=en#!/wiki/Tivoli%20Documentation
%20Central).

Tivoli Monitoring community on Service Management Connect
Connect, learn, and share with Service Management professionals: product support technical experts who
provide their perspectives and expertise.

For information about Tivoli products, see the Application Performance Management community on SMC
at IBM Service Management Connect > Application Performance Management (http://www.ibm.com/
developerworks/servicemanagement/apm).

For introductory information, see IBM Service Management Connect (http://www.ibm.com/
developerworks/servicemanagement).

Use Service Management Connect in the following ways:
v Become involved with transparent development, an ongoing, open engagement between other users

and IBM developers of Tivoli products. You can access early designs, sprint demonstrations, product
roadmaps, and prerelease code.

v Connect one-on-one with the experts to collaborate and network about Tivoli and the (enter your
community name here) community.

v Read blogs to benefit from the expertise and experience of others.
v Use wikis and forums to collaborate with the broader user community.

Other sources of documentation
You can obtain additional technical documentation about monitoring products from other sources.
v Tivoli wikis

IBM Service Management Connect > Application Performance Management (http://www.ibm.com/
developerworks/servicemanagement/apm) includes a list of relevant Tivoli wikis that offer best
practices and scenarios for using Tivoli products, white papers contributed by IBM employees, and
content created by customers and business partners.
Two of these wikis are of particular relevance to IBM Tivoli Monitoring:
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– The IBM Tivoli Monitoring Wiki (https://www.ibm.com/developerworks/community/wikis/
home?lang=en#!/wiki/Tivoli%20Monitoring) provides information about IBM Tivoli Monitoring and
related distributed products, including IBM Tivoli Composite Application Management products.

– The Tivoli System z® Monitoring and Application Management Wiki provides information about the
OMEGAMON XE products, NetView® for z/OS, Tivoli Monitoring Agent for z/TPF, and other
System z monitoring and application management products.

v IBM Integrated Service Management Library
http://www.ibm.com/software/brandcatalog/ismlibrary/
IBM Integrated Service Management Library is an online catalog that contains integration
documentation and other downloadable product extensions.

v Redbooks®

http://www.redbooks.ibm.com/
IBM Redbooks and Redpapers include information about products from platform and solution
perspectives.

v Technotes
Technotes provide the latest information about known product limitations and workarounds. You can
find Technotes through the IBM Software Support Web site at http://www.ibm.com/software/
support/.
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Support information

If you have a problem with your IBM software, you want to resolve it quickly. IBM provides ways for
you to obtain the support you need.

Online
The following sites contain troubleshooting information:
v Go to the IBM Support Portal (http://www.ibm.com/support/entry/portal/software) and

follow the instructions.
v Go to IBM Service Management Connect > Application Performance Management

(http://www.ibm.com/developerworks/servicemanagement/apm) and select the appropriate
wiki.

IBM Support Assistant
The IBM Support Assistant (ISA) is a free local software serviceability workbench that helps you
resolve questions and problems with IBM software products. The ISA provides quick access to
support-related information and serviceability tools for problem determination. To install the ISA
software, go to IBM Support Assistant (http://www-01.ibm.com/software/support/isa).

Troubleshooting Guide
For more information about resolving problems, see the product's Troubleshooting Guide.

Using IBM Support Assistant
The IBM Support Assistant is a free, stand-alone application that you can install on any workstation. You
can then enhance the application by installing product-specific plug-in modules for the IBM products you
use.

The IBM Support Assistant saves you the time it takes to search the product, support, and educational
resources. The IBM Support Assistant helps you gather support information when you need to open a
problem management record (PMR), which you can then use to track the problem.

The product-specific plug-in modules provide you with the following resources:
v Support links
v Education links
v Ability to submit problem management reports

For more information, and to download the IBM Support Assistant, see http://www.ibm.com/software/
support/isa. After you download and install the IBM Support Assistant, follow these steps to install the
plug-in for your Tivoli product:
1. Start the IBM Support Assistant application.
2. Select Updater on the Welcome page.
3. Select New Properties and Tools or select the New Plug-ins tab (depending on the version of IBM

Support Assistant installed).
4. Under Tivoli, select your product, and then click Install. Be sure to read the license and description.

If your product is not included on the list under Tivoli, no plug-in is available yet for the product.
5. Read the license and description, and click I agree.
6. Restart the IBM Support Assistant.
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Obtaining fixes
A product fix might be available to resolve your problem. To determine which fixes are available for your
Tivoli software product, follow these steps:
1. Go to the IBM Software Support website at http://www.ibm.com/software/support.
2. Under Select a brand and/or product, select Tivoli.

If you click Go, the Search within all of Tivoli support section is displayed. If you don't click Go,
you see the Select a product section.

3. Select your product and click Go.
4. Under Download, click the name of a fix to read its description and, optionally, to download it.

If there is no Download heading for your product, supply a search term, error code, or APAR number
in the field provided under Search Support (this product), and click Search.

For more information about the types of fixes that are available, see the IBM Software Support Handbook at
http://www14.software.ibm.com/webapp/set2/sas/f/handbook/home.html.

Receiving weekly support updates
To receive weekly e-mail notifications about fixes and other software support news, follow these steps:
1. Go to the IBM Software Support website at http://www.ibm.com/software/support.
2. Click My support in the far upper-right corner of the page under Personalized support.
3. If you have already registered for My support, sign in and skip to the next step. If you have not

registered, click register now. Complete the registration form using your e-mail address as your IBM
ID and click Submit.

4. The Edit profile tab is displayed.
5. In the first list under Products, select Software. In the second list, select a product category (for

example, Systems and Asset Management). In the third list, select a product sub-category (for
example, Application Performance & Availability or Systems Performance). A list of applicable
products is displayed.

6. Select the products for which you want to receive updates.
7. Click Add products.
8. After selecting all products that are of interest to you, click Subscribe to email on the Edit profile

tab.
9. In the Documents list, select Software.

10. Select Please send these documents by weekly email.
11. Update your e-mail address as needed.
12. Select the types of documents you want to receive.
13. Click Update.

If you experience problems with the My support feature, you can obtain help in one of the following
ways:

Online
Send an e-mail message to erchelp@ca.ibm.com, describing your problem.

By phone
Call 1-800-IBM-4You (1-800-426-4968).

Contacting IBM Software Support
IBM Software Support provides assistance with product defects. The easiest way to obtain that assistance
is to open a PMR or ETR directly from the IBM Support Assistant.
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Before contacting IBM Software Support, your company must have an active IBM software maintenance
contract, and you must be authorized to submit problems to IBM. The type of software maintenance
contract that you need depends on the type of product you have:
v For IBM distributed software products (including, but not limited to, Tivoli, Lotus®, and Rational®

products, as well as DB2® and WebSphere® products that run on Windows or UNIX operating
systems), enroll in Passport Advantage® in one of the following ways:

Online
Go to the Passport Advantage website at http://www-306.ibm.com/software/howtobuy/
passportadvantage/pao_customers.htm .

By telephone
For the telephone number to call in your country, go to the IBM Software Support website at
http://techsupport.services.ibm.com/guides/contacts.html and click the name of your
geographic region.

v For customers with Subscription and Support (S & S) contracts, go to the Software Service Request
website at https://techsupport.services.ibm.com/ssr/login.

v For customers with Linux, iSeries®, pSeries, zSeries, and other support agreements, go to the IBM
Support Line website at http://www.ibm.com/services/us/index.wss/so/its/a1000030/dt006.

v For IBM eServer™ software products (including, but not limited to, DB2 and WebSphere products that
run in zSeries, pSeries, and iSeries environments), you can purchase a software maintenance agreement
by working directly with an IBM sales representative or an IBM Business Partner. For more information
about support for eServer software products, go to the IBM Technical Support Advantage website at
http://www.ibm.com/servers/eserver/techsupport.html.

If you are not sure what type of software maintenance contract you need, call 1-800-IBMSERV
(1-800-426-7378) in the United States. From other countries, go to the contacts page of the IBM Software
Support Handbook on the web at http://www14.software.ibm.com/webapp/set2/sas/f/handbook/
home.html and click the name of your geographic region for telephone numbers of people who provide
support for your location.
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Notices

This information was developed for products and services offered in the U.S.A. IBM may not offer the
products, services, or features discussed in this document in other countries. Consult your local IBM
representative for information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product, program, or service that
does not infringe any IBM intellectual property right may be used instead. However, it is the user's
responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not give you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law :

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore,
this statement might not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX 78758 U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurement may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject to change without
notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to change before the
products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. You may copy, modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application programs conforming
to IBM's application programming interfaces.
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Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows: © (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. 2013. All rights reserved.

If you are viewing this information in softcopy form, the photographs and color illustrations might not be
displayed.
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